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Important News:  

The Exton library is having 
problems with the roof. 

This has resulted in 
EPCC having to cancel 

our meetings for August 
and September. The 

library is using the Struble 
community room for their own needs. We 
had the room reserved for our meetings, 
which we pay for, however the library is 
using the rooms as they need. 

 We are hoping to be back on schedule by 
October. We will keep you informed as to 
the schedule thru the news letter and our 
Web Site. 

Keep checking the web site at 
"extonpc.org". You will also receive a 
notice by email when the newsletter* is 
issued.  *Editor Note:  Newsletter will continue. 

 We had the following programs 
scheduled: 

 

August 2nd.  Free Software Overview by 
Izzi Bourrie 

September 13th   Protect Yourself Against 
Identity Theft by George Bourrie 

October 4th   Presentation by "Best Buy" 
the latest digital and electronic items 
available for the holidays. 

December 6th. OPEN HOUSE with 5 or 6 
Demonstrations set ups around the 
room for you to get answers to your 
questions on the following subjects:  Net 
Books, Digital Imaging, Saving memories, 
the latest  Anti-Virus software  and other 
items of interest.   

 When we get back in the library we may 
have to shuffle the programs around to 
different dates depending on the personal 
schedules of the presenters.  KEEP 
CHECKING THE NEWS LETTER AND WEB 
SITE FOR UPDATES. 

 Thanks, Jack Stretch 

THE EXTON PC COUNCIL www.ExtonPC.org 

 

All meetings are free and open to the public   ==    Bring a friend 
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< - - Tentative Future Meetings >             

September 8 

Board meeting 

(Location to be announced) 

October 13 

Board meeting 

November 

No Monday Meeting  

November 10 

Board meeting 

December 6 

Open House: 

Includes Net books, Saving Memories, 
Latest Anti-Virus and much more…    

December 

No Board meeting  

Music-- Capture it, Organize it 
and Enjoy it - Part 2 
by Phil Sorrentino 
Member of the Sarasota Personal Computer 
Users Group, Inc. 

Last month we discussed the History of digital 
music and how it is created. Now it’s time to 
organize that Music and create a Music Folder 
so that it can be the repository of all the music 
you Rip, purchase, or convert from analog 
sources; basically your Music Library. There 

are many ways of organizing the Music folder 
with sub folders. Before we do that it is 
probably worth a review of the data that is 
kept with each music file to see if it can be of 
any use in determining the organization of 
these folders. What data? you say. Well along 
with the actual music, in each music file, there 
is data that describes the music part of the 
file. This type of data is called metadata.  

So, metadata is data that describes other data 
(in this case the music). The music metadata is 
called ID3 Tag Data and is defined by the 
ID3v2 specification. ID3 Tag Data includes 
descriptive items such as: title, artist, album, 
track number, genre, year, copyright, stereo, 
length, composer, rating, etc., as well as the 
album cover art graphics. ID3 Tag Data is 
created when the original MP3 data file is 
created. The ID3 Tag Data is not easily 
modified unless you use an ID3 Tag Editor like 
MP3Tag, which was discussed in the March 
2010 issue of the Monitor. (In short, MP3Tag 
allows the user to modify the ID3 Tag Data 
that is created along with the MP3 file when a 
tune is initially created, or ripped from a CD.) 
The reason that ID3 Tag Data is important is 
because Music players, like Windows Media 
Player (WMP) and iTunes use the ID3 Tag Data 
to organize and present your music library. A 
music tune will show up according to the ID3 
Tag Data, which may not be where you think it 
should show up if you are only looking at the 
file name. This will probably not be a problem 
if all of your tunes come from CDs or are 
downloaded, but if you convert any from vinyl 
or tape to MP3, the ID3 Tag Data may not be 
what you think it should be. Also, if you want 
to change where particular artists show up, 
you might have to change the ID3 Tag Data for 
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that artist. Some CD compilations of tunes 
have the artist as “Various Artists”, which will 
put that tune under “V”, probably not where 
you would expect to find it. So, it’s good to 
have an ID3 Tag Editor so you can make any 
changes to the ID Tag Data to put the tunes in 
the places you want them. Once the tunes 
that need changes to the ID3 Tag Data are 
changed, the library will be presented as you 
expected, typically artists or songs 
alphabetically arranged, although, you can 
also view the library based on other items 
such as Genre, Album, Year, or even Rating. 
Rating is a number that you give to a tune, 
typically one to five. The Rating can then help 
you find a tune or present a specific view of 
your music library. (For example, you could 
show all the tunes with a rating of 4 or better.)  

So the ID3 Tag Data determines how the music 
library will be presented, but we still may 
want to organize the under-lying folders for 
convenience. This is not necessary, but it 
might allow the music to be viewed easily 
(using Windows Explorer), without using a 
Music Player. When CDs are Ripped, they are 
put into folders for the Artist, with the Album 
being a sub-folder. You might continue this 
and just put all the Artist folders into a Music 
folder. Then, it would be easy to find any tune 
with just the Artist and Album names. This is 
in general a very good way to organize your 
Music Folder. The only difficulties that might 
arise are those associated with converted 
tapes and disks, but you will just have to see 
how best they can each fit into your overall 
scheme. A simpler, but less desirable scheme 
might be just one Music Folder with every 
tune included. The tunes would then be 
alphabetically arranged by the file name. This 

can lead to one very big file, but for small 
Music Libraries, this may be acceptable. You 
could even create separate music Folders for 
specific music genres, like Music-Big Band, 
Music-Country, Music-Pop; it’s really your 
choice. 

Playlists are next. Now that we have a Folder 
organization for our Music Folder, we can take 
advantage of that organization to find tunes to 
include in Playlists. Playlists are just as you 
would expect, they are lists of tunes to Play, 
without any manual intervention. Playlists can 
include as many tunes as you would like, only 
limited by the number of tunes in your library. 
You could easily create a playlist that would 
last all day. Playlist files are another file type. 
The original playlist file type is M3U. WMP can 
be set to use M3U but prefers another 
Microsoft file type, WPL. M3U has a very 
simple file structure which is just a text list of 
files. WPL is a little more complex and 
probably a little more capable and written in 
HTML. Both work fine and it is impossible to 
tell which is being used without looking at the 
file types. If you have no reason to prefer one 
over the other, use your Music Player’s default 
type. (Either file can be modified using 
Notepad, not Wordpad or Word, if necessary. 
Notepad is a simple text editor that does not 
include any formatting information.) This 
should not be undertaken lightly. Modifying a 
file with a text editor should only be done with 
great caution, and only by a person who is 
confident of the file structure. An error in the 
file structure may make the file non-useable, 
so do this only if absolutely necessary. Once 
you have decided on the Playlist file type, or 
just accepted to use the default, you can start 
to create Playlists. Just think of a theme and 
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then find all the tunes that support that 
theme. Using WMP, playlists are easily created 
by showing the Library in any view, such as by 
Artist, and then dragging-and-dropping the 
tunes for the Playlist over to the Playlist pane 
on the right side of the screen. After you have 
all the tunes in the list, give it a name and save 
it and that’s all there is to it. While you’re at it 
you might want to create a Playlist for each 
Artist so that you can review all of the tunes 
for that specific artist. In this case, the artist is 
the theme. You might even like this playlist for 
“an evening with a Sinatra, or Elvis, or the 
Beatles”. 

Now you’re ready to take advantage of all that 
music entertainment, laboriously stored in the 
Music Folders. One last item to consider is 
using your music on other machines on your 
network. If you don’t have a home network 
now, you probably will in the future. For 
simplicity and convenience it makes sense to 
have only one Music Folder, kept on your 
main computer (acting as a Music Server), and 
to use it on every other machine on your 
network. This way there is only one Music 
Folder to be backed-up. WMP can easily be set 
up for Sharing Media. Select Tools-Library-
Configure Sharing…, and check the Share 
Media check box. Then choose the devices, on 
the network, to Allow sharing of music. This 
will allow other machines to use the media in 
the Server’s Music Library. By the way, all of 
the music in your Music Library can also be 
used on any of the portable MP3 music 
players, like Apple’s iPod or SanDisk’s Clip. 
WMP provides the ability to “Sync” your music 
to a portable device. Briefly, to share a 
Playlist, plug your device into a USB port and 
choose Sync on the Selection Bar, choose the 

playlist and select Sync. (Obviously, the 
memory in the portable device must be large 
enough to hold all the tuned in the playlist.) 

Recorded music is only about 133 years old if 
we consider Edison’s invention in 1877 as its 
practical beginning. (There were earlier 
patents on devices that could record but not 
playback the recording.) Recorded music has 
come a long way from Edison’s time to the 
present when almost any recorded music can 
be obtained and stored indefinitely on our 
personal computers, and then played and 
shared almost effortlessly. The computer, 
besides all of its other jobs, can be a great 
music entertainment center. If you haven’t 
started yet, what are you waiting for? Get 
started creating your own Music Library so 
you and your family can enjoy the fruits of the 
past 133 years and your current efforts. : 

This article is from the August 2010 issue of 
the Sarasota PC Monitor, the official monthly 
publication of the Sarasota Personal Computer 
Users Group, Inc., P.O. Box 15889, Sarasota, FL 
34277-1889. Permission to reprint is granted 
only to other non-profit computer user 
groups, provided proper credit is given to the 
author and our publication.  

For further information about our group, 
email: admin@spcug.org//  Web: 
http://www.spcug.org/   

Tips.Net for Word and Excel 

Slowing Down Mouse Selection 

Have you ever noticed that there are times 
that text scrolls way too fast on your screen 
when you are trying to select it using the 
mouse? There are many ways you can attempt 
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to slow down the speed at which text scrolls 
when you are using the mouse to select text. 
Perhaps the easiest is to use the keyboard in 
conjunction with the mouse. You do this by 
clicking the insertion point at the position 
where you want the selection to start, and 
then hold down the SHIFT key while you click 
where you want the selection to end. 

However, if you don’t want to use the 
keyboard, and only rely on the mouse, your 
options are a bit more limited. Perhaps the 
best idea is to get a mouse that has a scrolling 
wheel between the two buttons. Using the 
wheel you can scroll through a document at 
the speed you want. 

Those who have used Word for a while know 
that there are actually two mouse-scrolling 
speeds in Word. To use the slower speed 
when selecting text, move the mouse down to 
the horizontal scrollbar area. This scrolls 
downward at a relatively moderate speed. 
Moving the mouse below the horizontal 
scrollbar sends the scrolling into full-speed 
mode. The “moderate speed” zone for 
scrolling upward is the ruler bar. The actual 
differences between these scroll speeds 
depend on the speed of your computer and 
how many other tasks your system is running. 

The final option to try is to slow down the 
mouse speed using Windows itself. Display the 
Control Panel, and then open the Mouse 
applet. (How you access both the Control 
Panel and the Mouse applet will vary, 
depending on your version of Windows.) 
Within the Mouse applet, make sure the 
Motion tab is displayed. You can adjust the 
Pointer Speed setting on this tab so it is more 

toward the slow side. When you close the 
applet by clicking on OK, you should notice 
that your mouse speed is a bit more 
manageable. 

Copyright © 2010 by Sharon Parq Associates, Inc. 
Reprinted by permission. Thousands of free Microsoft 
Word tips can be found online at http://word.tips.net. 

 

Defining Shortcut Keys for Symbols 

When you need to insert a special symbol into 
a cell, the normal way to do it is by using the 
Insert Symbol dialog box. If you need to insert 
the same symbol quite often, you may want a 
way to assign the symbol to a shortcut key so 
you can insert it easier. 

Some symbols have obvious shortcut keys, 
defined by the folks in Redmond. One of the 
lesser-known facts is that every symbol has a 
“shortcut” key, but using that shortcut may 
not seem that short. How does this work? By 
holding down the ALT key as you type the 
ASCII or ANSI code for the symbol. 

For instance, let’s say you want to enter the 
cents symbol. If you display the Insert Symbol 
dialog box and select the cents symbol, at the 
bottom right of the dialog box you can see the 
character code for the symbol (it is 00A2). This 
is a hexadecimal number; you need to convert 
it to regular decimal notation. You can do this 
by using the formula =HEX2DEC("00A2"), 
which returns the value 162. If you remember 
this code, you can hold down the ALT key as 
you type the code, with a leading zero, on the 
numeric keypad.  

http://word.tips.net/
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This approach works great if you only need to 
input a few symbols on a regular basis; it 
doesn’t take much work to remember those 
few codes you need. However, if you have a 
lot of symbols you need to work with, and 
then remembering codes becomes more 
problematic. You could develop your own 
printed “cheat sheet” for the symbols so that 
you can refer to it all the time, or you could 
rely on Excel’s AutoCorrect feature to do the 
remembering for you. Follow these steps: 

1. Use the Insert Symbol dialog box to 
insert the symbol into a cell. 

2. Select the cell that contains the 
symbol. 

3. Press F2 to start editing the cell. 

4. Select the symbol, and only the 
symbol. 

5. Press CTRL+C to copy the symbol to 
the Clipboard. 

6. Display the AutoCorrect tab of the 
AutoCorrect dialog box. (In Excel 2010 
display the File tab of the ribbon, click 
Options, click Proofing, and then click 
AutoCorrect Options. In Excel 2007 
click the Office button, click Excel 
Options, click Proofing, and then click 
AutoCorrect Options. In older versions 
of Excel choose AutoCorrect options 
from the Tools menu.) 

 

The AutoCorrect tab of the AutoCorrect dialog box. 

7. In the Replace field, type a short 
mnemonic for the symbol. This should 
be a series of letters that are not a 
real word, such as hrt, which might be 
the mnemonic for a heart symbol. 

8. In the With field press CTRL+V to paste 
the symbol from the Clipboard. 

9. Make sure the Formatted Text radio 
button is selected. 

10. Click OK.  

Now you can just type the mnemonic when 
you want the symbol to appear. When you 
type the space bar after the mnemonic, 
AutoCorrect kicks in and replaces it with the 
symbol. 

Copyright © 2010 by Sharon Parq Associates, Inc. 
Reprinted by permission. Thousands of free Microsoft 
Excel tips can be found online at http://excel.tips.net. 

 

http://excel.tips.net/
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Customizing Word 2007 - 

Creating Your Own ñNormalò 

Template  

by Nancy DeMarte, ndemarte@verizon.net  

Member of the Sarasota Personal Computer Users 

Group, Inc.  

If you want to create documents with new and 
colorful formats, Word 2007 offers some 
interesting options with the Quick Styles 
gallery, a new feature located on the Home 
tab. This gallery contains sixteen templates, 
each available in Live Preview and able to be 
selected with a click. Each style template 
includes certain fonts and font effects, such as 
color, size, bold or italic, and line spacing. The 
first two styles, Normal and No Spacing, apply 
to the body text in documents; the rest apply 
to parts of documents, such as headings or 
subheadings. The default style, or the one you 
get if you open a new document, is Normal 
(normal.dotm). In 2007 the normal template 
contains several variations from the Word 
2003 normal template, some of which started 
to bother me the first time I typed with Word 
2007. For one thing, it uses two new fonts, 
Calibri for the body text and Cambria for 
headings. At an 11 point size, these fonts 
seem too small for my older eyes. The space 
between lines in a paragraph (1.15) is a bit 
larger than single space, and the space after 
paragraphs at 10 points seems wastefully 
large. The margins in the new normal 
template are 1" on each side. I prefer smaller 
margins for most documents. This new Normal 
style is modern and gives a sleek, open look to 
a document, but it’s possible that many users 
moving from Word 2003 to Word 2007 are 
finding its quirks irritating.  

I decided to try to change the Normal Style in 
Word 2007 to be more like the one I was used 
to in 2003. I found several possible 
approaches to this task, but finally settled on a 
process which worked for me. Below are the 
steps I used to change Word 2007’s normal 
style to one that I preferred: 

First I set myself a plan. I decided that I 
wanted to change only the font, the font size, 
the space between lines in a paragraph, the 
space allowed before and after paragraphs, 
and the margins. I thought it wise to alter only 
the basics, knowing I could always make 
changes manually for special documents or 
rework the normal template if I wasn’t happy 
with it. To change any of these things, I found I 
needed to work in a dialog box that had a 
Default button which would save my changes 
for use in future documents. I began by 
opening Word 2007. On the Home tab in the 
Font group I clicked the dialog box launcher, a 
tiny arrow in the lower right corner of that 
group. This opened a familiar dialog box from 
Word 2003 containing all sorts of font-related 
options. I changed the font to Times New 
Roman, which, along with Arial, was one of 
the standards for Word 2003. I set the font 
size to 12 points. I would have set it to 10 if I 
had chosen Arial. These are typical sizes for 
average documents. Then I clicked the Default 
button and selected Yes when asked if I 
wanted this change to affect all future 
documents.  

Then I clicked the dialog box launcher arrow in 
the Paragraph group and set the line spacing 
to Single Space and the Space before and 
Space after paragraphs to .6. Again, I clicked 
Default and answered Yes.   

mailto:ndemarte@verizon.net
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The Control Panel -- Extremely Useful 
by Sandy Berger 

www.compukiss.com  

Just as you can use a car without manipulating 
anything under the hood, you can also use a 
computer without changing any settings. 
However, at a certain point you will want to 
correct a setting, uninstall a program, change 
the way your mouse works, or add another 
user to your computer. All of these functions 
and many more are found in the Windows 
Control Panel. Don't worry though; the 
Control Panel is much easier to navigate than 
the cables, wires, and mechanisms that you 
find under the hood of a car....and you can use 
the tools in the Control Panel without getting 
your hands dirty.  
 
In geek-speak, the Control Panel is the central 
location for all of the Windows operating 
system configuration needs. In everyday 
terms, it the place where you can work with 
the many tools that Windows offers to change 
and customize all of the settings. The Control 
Panel is part of the Window's operating 
system's graphical interface. As such, you will 
find that it consists of easy-to-understand 
icons that are each labeled as to their 
function. 
 
The Control Panel has been around since the 
first version of Windows. Over the years, it has 
morphed into a very useful set of 
management tools for your computer. In a car 
you need to know where the hood release 
lever is, in Windows, you need to know how to 
access the Control Panel. 
Windows Vista and Windows 7, you can access 

the Control Panel by clicking on the Start 
button and choosing Control Panel from the 
right column of choices. In Windows XP, you 
will click Start, then choose Control Panel from 
the left column. If you don't see the Control 
Panel listed, click on Settings from the left 
column and then click on Control Panel. 
 
The Control Panel is a little different in 
Windows XP than it is in Vista and Windows 7. 
So let's talk about XP first. By default, the 
Windows XP Control Panel appears in what is 
called "Category View". This means that 
various functions have been put into 
Categories. Previous versions of Windows 
showed a list of icons, one for each function, 
in Windows XP, this is called the "Classic 
View". When you open the Control Panel in 
Windows XP if you see several categories 
listed you are in "Category View". If you see a 
window full of individual icons, you are in 
"Classic View". You can change the view by 
clicking on the words "Switch to Classic View" 
or "Switch to Category View" which is on the 
left side of the screen. Check out these two 
options and see which one you like. You can 
switch between them quite easily at any time. 
 
In Windows Vista, you have the same choices, 
but you may have to click on "Control Panel 
Home" on the left side of the screen before 
you can click on "Classic View" or "Category 
View". 
 
Microsoft made some changes in the Control 
Panel in Windows 7. They have eliminated the 
name Classic View. In Windows 7 you will see 
the words "View by" on the upper right side of 
the screen. Click on the down arrow next to 
those words and you will have three views to 

http://www.compukiss.com/articles/the-control-panel-extremely-useful.html
http://www.compukiss.com/
http://www.compukiss.com/articles/the-control-panel-extremely-useful.html
http://www.compukiss.com/articles/the-control-panel-extremely-useful.html
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choose from: Category, Large Icons, or Small 
Icons. This Icon view is really the same as the 
Classic View. I prefer to use the Classic or Icon 
view, but again, you can check out all the 
views and see which one you like best. 
 
There are 45 icons in the icon view in 
Windows 7 and about the same number in 
previous versions. If you look at the Classic or 
Icon view, you will see that the icons have 
labels, like Display, Sound, Power Options, 
Mouse, Keyboard, User Accounts, Folder 
Options, and Devices and Printers. You can 
click on any of these icons to open a window 
that will allow you to adjust, correct, and/or 
customize the settings of these areas. Take a 
look around. Check out Mouse area first. 
When you click on the mouse icon a windows 
with options will appear. It will have tabs at 
the top. You can click on each tab to see even 
more options. If you have never looked at 
these before you will be amazed at the 
number of things that you can do to customize 
your mouse. You can switch the buttons if you 
are left-handed. You can speed up and/or slow 
down the double-click speed. You can change 
the looks of the pointer. I you are using a 
mouse with a scroll wheel, you can even 
change how the wheel behaves. 
 
Try a few things. The only caveat here is to 
document the changes that you are making so 
you can change them back if you want to. 
 
Each of the items in the Control Panel allows 
you to change the settings in your computer. 
Look through and open up a few of them. 
There are hundreds of things that you can 
change and/or customize in the Windows 
operating system. Some of the Control Panel 

items are very useful for everyday tasks in 
Windows. Be sure to take a look.  

Dave Gerber, Director/PUSH Chairman; 7424 Cass 
Circle; Sarasota, Fl 34231; 941-926-5388 (phone); 

PUSH@apcug.net; Skype: floridamysticruler    

 

Participants Needed for 
Open House on 

December 6, 2010! 
 

Members:  Please consider 
volunteering at our Open House to 

demonstrate what you are doing at home 
and/or on the outside in your job.   

New ideas are always welcome! 

Need Computer Help? 

 

Visit our Help Desk and Discussion Group at 
http://tech.groups.yahoo.com/group/epcc/ 

Contribute a Newsletter Article 

All members are encouraged to submit 
articles or other items of interest for 

possible Newsletter publication.  

The deadl ine for articles to appear in the 
next issue is the 1st Monday of the month.   

http://www.compukiss.com/articles/the-control-panel-extremely-useful.html
http://www.compukiss.com/articles/the-control-panel-extremely-useful.html
http://www.compukiss.com/articles/the-control-panel-extremely-useful.html
mailto:PUSH@apcug.net
http://tech.groups.yahoo.com/group/epcc/
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(Continued :  Contribute a Newsletter Article )  

All articles are gladly accepted at anytime 
for our future publication s.  

When you send your contribution as an e -
mail attachment, please  save your text file 

in text  (*.txt) or M S Word Format (*.doc) ; 
Images  are  to be saved in Jpeg Format.  

Please send to: Stephanie Varis 

svaris@verizon.net   

 

We are Seeking New 
Technology Interest Groups! 

If you want to start a new interest group in 
computer technology, web, photography, 

film-making, etc., please contact us! 

 Are you Interested in Becoming 
a Guest Speaker?  

We are greatly interested in bringing in 
new guest speakers!  Please contact us 

and share! We appreciate your 
participationé 

MEMBERSHIP 2010 

Thank you to those who have renewed.  
We welcome New Members who joined us! 
Please encourage family & friends to join... 

Please see the Exton PC Council 
membership form on the following pageé   

Whoôs Who at EPCC 

 

Directors 

Isabelle Bourrie (484) 995-5012 ibourrie@voicenet.com 

Bob Linaberry (610) 873-0204 rl55@verizon.net 

Jim McKittrick (610) 647-8188 JMcKit@ccil.org 

Gabe Preston (610) 436-0311  GabePreston@comcast.net 

Salvatore Sano (610) 269-5096 SalvatoreSano@yahoo.com 

Michael Shephard       joelise@gmail.com 

Program Contacts 

Digital Imaging Bob Linaberry       rl55@verizon.net 

Microsoft Windows Doug Fairchild (610) 696-8223 
  db64fair@verizon.net 

Microsoft Publisher Jack Stretch (610) 363-6328 
  JLStretch@comcast.net 

Microsoft Office/Works Salvatore Sano 

Staff Positions 

Newsletter Editor Stephanie Varis      svaris@verizon.net 

Newsletter Mailing Sal Sano  SalvatoreSano@yahoo.com 

Communications Charlie Eisenfelder Caeilop@aol.com 

Membership Joseph Holzman  m28@verizon.net  

Treasurer Nate Rosenthal (610) 970-5122 
 n2add@arrl.net 

Webmaster    Bob Linaberry rl55@verizon.net 

CHESCO Library Liaison Diane Gring 

 

mailto:svaris@verizon.net
mailto:ibourrie@voicenet.com
mailto:rl55@verizon.net
mailto:JMcKit@ccil.org
mailto:GabePreston@comcast.net
mailto:SalvatoreSano@yahoo.com
mailto:joelise@gmail.com
mailto:rl55@verizon.net
mailto:db64fair@verizon.net
mailto:JLStretch@comcast.net
mailto:svaris@verizon.net
mailto:SalvatoreSano@yahoo.com
mailto:Caeilop@aol.com
mailto:m28@verizon.net
mailto:n2add@arrl.net
mailto:rl55@verizon.net
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Your Membership Is Welcome! 

Non-members and former members are encouraged to join. 

Please fill in the Membership Application below and mail it with your check now!   

 

EXTON PC COUNCIL (EPCC) 2010 MEMBERSHIP APPLICATION / RENEWAL  

 

Membership includes email notices, privilege to post on EPCCôs Yahoo Groups, privilege to participate in 
special prize give away raffles at various meetings and affords additional benefits of special offers through the 
national APCUG (Association of Personal Computer User Groups). 

 

New Member: $25.00 ______ Renewal: $20.00 ______ Date_________________ 

Notice of downloadable ExtonPC.Org News will be emailed monthly ï Add $5.00 to above fees to 

receive copy by postal mail and mark here. ______ (To cover cost of postage and mailing) 

Last Name: _______________________________ First Name _______________________________ 

If you are a current member and renewing, fill in all changes only below.  Otherwise fill in all information. 

ADDRESS: ___________________________________________________ 

CITY: _________________________ STATE: ____ ZIP: ______________ 

HOME PHONE: _________________________ WORK PHONE: _____________________ (Optional) 

EMAIL (please update and print clearly): _____________________________________________________  

 

Exton PC Council 

310 North High Street 

West Chester, PA 19380 

http://www.extonpc.org 

Mailing 

Address 

Goes 

Here 

Place 

Postage 

Here 


